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eCatalogs
Electronic product catalogs, also known as eCatalogs, are data files in STEP that contain product and price
information for a specific product selection, typically stored in a product collection.

eCatalog Elements
An eCatalog object consists of three elements:

l A collection of the products go into the eCatalog. A collection can be either dynamic or static.
l A price list, which contains the prices that are valid for the eCatalog. A price list consists of product with its
terms. A term for a product is a combination of a value and a set of conditions such asMinimumQuantity,
MaximumQuantity, Start Date, and End Date.

l An eCatalog configuration, which specifies the output format, the deliverymethod, and themapping
between internal product attributes and the attributes of the export format.

eCatalog Price Lists and Commercial Data Lists
Price lists used in eCatalogs are identical in format to the price lists used for commercial data in Print Publisher.
They contain the same elements (Value, Unit, Quantity, Dates), use the same default SystemSetup commercial
object type of Price (Price), and aremapped identically in the Import Manager. The difference between the two is
in their intended output. eCatalog price lists are intended for electronic output, and commercial data lists are
strictly used in Print Publisher print publications.

Since eCatalog price list import configurations aremapped using commercial data options in the Import
Manager, the term 'commercial data' is frequently used in this guide to refer to the contents of eCatalog price
lists. For more information on commercial data, refer to theCommercial Data section of thePublisher (Adobe
InDesign Integration) documentation.
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Creating an eCatalog
To create a new eCatalog, follow these steps.

1. In the Tree, select eCatalogs.
2. Right-click and selectNew eCatalog.

3. In the Create eCatalog dialog, enter an ID andName for the eCatalog, then clickCreate.

4. The eCatalog is created.
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The next steps are to add the following elements to your eCatalog:

l A price list that contains the prices that are valid for the eCatalog.
l A product collection that contains a list of all the products that go into the eCatalog.
l An eCatalog configuration that specifies the output format, the deliverymethod, and themapping
between internal product attributes and the attributes of the export format.
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Creating a Price List
A price list consists of terms. A term for a product is a combination of a value (price) and a set of conditions such
asMinimumQuantity, MaximumQuantity, Start Date, and End Date.

The first step when setting up your eCatalog is to create a price list that holds the prices of the eCatalog.

1. In the Tree, select the eCatalog that you want to create a price list for.
2. Right-click, and then clickNew Price List.

Note: The STEP object type used for eCatalog price lists, Price (Price), is the same default object type
used for Commercial Data price lists. If you are also using Commercial Data in your system, any
configurationsmade to the Price object type (e.g., setting an ID Pattern) will apply to eCatalog price lists.
Additionally, the eCatalog price list cannot have the same ID as a Commercial Data list that uses the Price
object type. For more information on Commercial Data, refer to theCommercial Data section of the
Publisher (Adobe InDesign Integration) documentation.

3. In theCreate Price List dialog, enter an ID and aName for the price list, then clickCreate.
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4. On thePrice List tab, the following optional settings are available.

l Immutable:When checked, this setting prevents commercial data from being updated.
l Act as selection list: Enable this option to have the products included in the price list serve as the product
selection for the eCatalog. If a collection is added to the eCatalog, the collection serves as the product list,
and this option will be disabled. For more information on adding a collection to an eCatalog, refer to the
Selecting Products for eCatalogs topic.

l Import Configuration: Specifies the import configuration to be used for the price list. Click the ellipsis button
( ) to select the saved import configuration.

l Currency:Click the ellipsis button ( ) to choose a currency unit for the list. This selection can be any unit
and does not have to be currency.

Note: This does not place the unit on price lists values. To have the unit display within terms lists, the unit
must be added when defining the import configuration bymapping the values of an Excel column to the
'Unit' aspect of the terms list. Refer toCreating an eCatalog Configuration for more information on
creating import configurations.
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l Last modification time:Displays the date and time that the list was last modified. This field is non-editable.
l Expiry date: Enter an expiration date for the list, or double-click the field to open the Date Picker.

Note: The price list will not expire automatically. The date is for administrative purposes only and is not
the same as the 'End Date' value that can be defined for individual terms. Refer toCreating an eCatalog
Configuration for more information on the 'End Date' value.

l Default Start-date and Default End-date: Like Expiry date, these values are for administrative purposes
only and are not the same as the 'Start Date' and 'End Date' values defined for individual terms.
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Defining Import Settings for Price Lists
eCatalog price list terms (commercial data) are imported into eCatalog price lists using standard Import
Manager functionality.

After creating a price list object for your eCatalog, the next steps are to create a sample import file, in Excel or
CSV format, then define the import settings for importing actual price data. The columns in the sample file will be
used tomap fields in the Import Manager wizard, which will allow the system to later ingest a sheet that contains
actual data.

Sample Excel Price List Load File
The following two screenshots show examples of price list import files, one containing price break and quantity
information, and the other one containing price break, quantity, unit, start date, and end date information.

Price Example

This example sheet is an Excel file that contains 10 columns and 8 products. Each product has three priceswith
price breaks that change based on the quantity of the product being sold.

For example, using the first product row shown in the below screenshot (ID = 121171), the price breaks are as
follows:

Break No. Quantity Price

1 1 - 3 2.79

2 4 - 9 1.79

3 10 - 100 0.89
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Note: To only import a price file with three prices, youmust set theMinimumandMaximum values (even if
they are fake values) to each of the prices. You cannot just load three columns of prices and nothing else. To
load three price breaks, youmust load nine columns of data. Unit, Start Date, and End Date are optional.

Prices with Units and Dates

To also importUnit, Start Date, andEnd Date values, which are optional, a corresponding column for each
valuemust also be present on the sheet. In the below example—which shows columns for 'Price1' only—there is
a 'P1Unit,' 'P1StartDate,' and 'P1EndDate' column. Each subsequent price (Price2, Price 3, and others) will also
have its own unit, start date, and end date columns.

Note:When importing units, theSTEP ID of the unit must be used and not the symbol. In the below
example, iso4217.unit.USD is the STEP ID for U.S. dollar ($).

Creating an Import Configuration for a Price List
The following steps for creating a price list import configuration use a sheet that contains columns for all available
price list (commercial terms) elements: value, unit, quantities, and dates. These steps assume that you have
already created a sample file. Throughout the Import Manager, the elements within the price list (terms) are
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referred to as commercial data.

1. In the Tree, expand the relevant eCatalog.
2. Select and right-click the price list that you want to import prices to, and then clickEdit import

configuration.

3. The Import Manager displays on theSelect Data Source screen.

Note: All steps of the Import Manager wizard, and the options available for each step, are described in
detail in theCreating a Data Import section of theData Exchange documentation. The information in
this topic only contains detailed descriptions of the steps that are of particular importance to commercial
data.

4. On this screen, select File. The data source will always be File for commercial data import configurations.
5. While still on theSelect Data Source screen, click the ellipsis button ( ) next to the Filename field and

choose the sample upload file, then clickNext.
6. On theSelect Format screen, the format will be prepopulated with either Excel or CSV, depending on the

format of your sample sheet.

7. Make any additional configurations ('HasHeader,' 'Trimwhitespace,' 'Use date and number formatting from
sheet'), then clickNext.

Note: It is strongly recommended to keep the default selection of no forUse date and number
formatting from sheet, especially if importing date values. This ensures that date values are

© Stibo Systems - Internal - Release 2023.3 (11.3) - September 2023 12



standardized into an ISO format. Refer to theExcel Format section of the Import Manager
documentation for more information.

Mapping Commercial Data in the 'Map Data' Step

In theMap Data step, a number of mappingsmust be specifiedmanually. The 'AutoMap' feature will not work
for commercial datamappings, though it can be used tomap the ID or Name columns. ID is required.

1. To start themappings, click a source column, then clickMap. TheMap Column to dialog displays.
2. Select the column tomap, then clickMap. TheMap to dialog displays.
3. In this example, the first column has already beenmapped to ID; the first price column, 'Price1,' has been

selected; and theCommercial Data radio button has been selected in theMap to dialog.
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4. The name of the price list will display in theData Set field.

5. From theGroup list, select the preferred quantity break.
6. Choose one of the following options to determine which field of the commercial list that the data from the

Excel sheet should bemapped to:

l SelectValue to map the column to the value field.
l SelectUnit to map the column to the unit field and have the unit display along with the term value.
l SelectMin. Quantity to map the column tominimumquantity in the selected group or price break.
l SelectMax. Quantity to map the column tomaximumquantity in the selected group or price break.

© Stibo Systems - Internal - Release 2023.3 (11.3) - September 2023 14



l SelectStart Date to map the column to the start date when the price becomes valid.
l SelectEnd Date to map the column to the end date of the selected group or price break.

5. Check theMandatory box if you want rowswithout a term value to be skipped on import so none of the
information that may be related to a product without a specified term value will be imported. ClickOK.

6. Follow the previous steps until all columns of the sheet aremapped. For example, in this sheet, after mapping
the 'Price1' column to Commercial Data > Group: 1 > Value, the remaining columnswill bemapped as
follows:

l The 'P1min' columnwill bemapped to Commercial Data > Group: 1 >Min Quantity
l The 'P1max' columnwill bemapped to Commercial Data > Group: 1 >Max Quantity
l The 'P1Unit' columnwill bemapped to Commercial Data > Group: 1 > Unit
l The 'P1StartDate' columnwill bemapped to Commercial Data > Group: 1 > Start Date
l The 'P1EndDate' columnwill bemapped to Commercial Data > Group: 1 > End Date
l The 'Price2' columnwill bemapped to Commercial Data > Group: 2 > Value, and so forth.

The remainder of the columnswill follow the same pattern. ClickNextwhen finished.

Completing the Import Configuration

1. On the Identify Objects screen, if the products in the source file are not identified as existing products in the
system, the 'Match Result' will be 'New.' ClickNext.

2. On the Identify Destination screen, several options are available, which are detailed at length in the Import
Manager - Identify Destination topic in the Import Manager documentation. For the purposes of
commercial data imports:

l Reject Updates should be left unchecked, since a setting on theAdvanced Settings screen of the
wizard will control how commercial lists are updated.
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3. On theSelect Business Rules screen, business rules can be specified to run upon import if required for
your business needs. For more details, refer to the Import Manager - Select Business Rules topic in the
Import Manager documentation. ClickNext.

4. On theAdvanced Settings screen, any options can be selected based on your business needs, but the only
options relevant to commercial data appear in theReplace/Update Options area.

l To delete all existing content of the commercial list(s) and replace it with the content of the new file, select
Replace entire existing list(s) with content of import file.

l To keep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, selectOnly update commercial data for objects included in import file.

For more information on all options available on theAdvanced Settings screen, refer to the Import
Manager - Advanced Settings topic in theData Exchange documentation.
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5. ClickFinish to complete the wizard. TheSave Import Configuration dialog displays. It is recommended to
save the import configuration and check 'Don't import now' in case changes need to bemade to the
configuration before importing live data. ClickOK.

Refer to theRunning a Data Import topic in theData Exchange documentation for information on how to
save the import configuration.

6. The price list import configuration is saved in the specified classification structure as an XML file of the object
type Import Manager Configuration (stibo.ImportManagerConfig).

7. A price list can now be imported. Refer to the next section of this topic, Importing Prices, for details.
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Editing a Saved eCatalog Import Configuration
Tomake changes to an existing eCatalog import configuration, do the following.

1. Right-click on the price list and selectEdit import configuration.

2. The Import Manager wizard displays, starting on theSelect Data Source screen.
3. Make the desired edits following the same steps listed above for creating a new configuration.
4. Alternatively, you can edit the configuration by right-clicking on the saved import configuration object in the

classification hierarchy. Refer to theMaintaining a Saved Import Configuration topic in theData
Exchange documentation for details.
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Importing Prices
eCatalog price lists are imported using standard Import Manager functionality. In STEPWorkbench, these
imports can be initiated fromSTEPWorkbenchmenu (i.e., File > Import > Data) or from the price list object itself.
This topic explains how to import commercial data information for eCatalog price lists through a right-click action
on the price list object.

To import eCatalog price information:

1. Right-click on the price list object and select Import Data.

2. In the Import Commercial Data dialog, click the ellipsis button ( ) next to Filename, then navigate to and
select the file you want to import.

Note: This file must match the format of the file saved in the import configuration.
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3. In theReplace/Update Terms area, select one of the following options:

l To delete all existing content of the commercial list(s) and replace it with the content of the new file, select
Replace entire existing list(s) with content of import file.

l To keep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, selectOnly update commercial data for objects included in import file.

The choice youmadewhen defining the import configuration on the Advanced Settings screen of the Import
Manager wizard will be set as default, but you can override this option by selecting the other option.

Note: If Immutable has been checked on the price list object, values cannot be updated regardless of
what option is chosen. Refer toCreating a Price List for more information.

4. Select Import on-line option if you want the process to run and show the result online instead of going to a
background process. Once the process completes, the Import Report window will show the complete report.

5. ClickOK.

To view the imported data, use one of themethods outlined in theViewing Price Lists topic.
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Viewing and Searching Price Lists
After importing a price list, the commercial data terms can be viewed both from the price list and from the
product that is included in the list. Additionally, the data can be searched when viewing it from the product.

View Terms from a Price List
1. Navigate to and select the relevant price list in your eCatalog.
2. On the Price List tab, expand theContent of area.
3. The contents of the price list are displayed.

Search Terms from a Price list

1. Navigate to and select the relevant price list in your eCatalog.
2. Select the relevant commercial list, then click thePrice List tab.
3. Expand theContent of area to view the content of the list.
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4. In theProduct field, enter a product name or ID, or use an asterisk to enter part of a name or ID, and then
clickSearch.

5. The search results are displayed.

6. To show the entire content of the list again, leave the search field blank, then clickSearch.
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View Terms from a Product
1. In the Tree, navigate to and select the relevant product.
2. On the Commercial tab, expand the Terms area.
3. All price lists that the product appears in are displayed. Any Publisher commercial data lists that the product is

linked to will also display. For more information on commercial data, refer to theCommercial Data section of
thePublisher (Adobe InDesign Integration) documentation.

It is also possible to edit terms lists from both locations. Refer to the next topic in this section, Editing Price Lists,
for more information.
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Editing Price Lists
After being imported, eCatalog price list terms can be edited, either from a price list or from a product.

Note: Price lists cannot be edited if the Immutable box has been checked on the price list object. Refer to
theCreating a Price List topic for more information.

Edit Price List Terms from a Price List
There are two ways to edit price list terms from a price list. TheValue andUnit can be edited directly from the
list. TheValue,Min Quantity,Max Quantity, Start Date, andEnd Date values can be edited by right-clicking
on a product in the list and accessing theEdit Terms dialog.

Editing Terms Directly

1. Navigate to and select the relevant price list, then click on thePrice List tab.
2. Expand theContent of section to view the content of the list.
3. Double-click in anyValue field to edit the value.
4. Click the ellipsis button ( ) in theUnit field to edit the unit.

Editing Terms from the Edit Terms Dialog

1. Navigate to and select the relevant price list, then click on thePrice List tab.
2. Expand theContent of section to view the content of the list.
3. Right-click the right arrow next to the preferred term, then chooseEdit Term.
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4. In theEdit Terms dialog, double-click inside the field for the term that you want to edit, then clickOK when
complete.

Add Terms to a Price List

1. Follow the steps outlined above to access theEdit Terms dialog.
2. ClickAdd Term to add a new row to the Edit Terms dialog.
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3. Enter the relevant term values in the new row, then clickOK.

Remove Terms from a Price List

1. Follow the steps outlined above to access theEdit Terms dialog.
2. In theEdit Terms dialog, right-click the arrow next to the term you want to remove, then chooseRemove

Term.

Add Products to a Price List

Instead of importing products into a price list, you can add productsmanually, for which you then can edit the
terms.
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1. Navigate to and select the relevant price list, then click on thePrice List tab.
2. Expand theContent of section to view the content of the list.

3. Right-click themenu icon (arrow) next to one of the terms in the table, and then clickAdd Product.
Alternatively, scroll to the bottom of the table-based view, then clickAdd Product.

4. In theAdd Product to Terms List dialog, click the ellipsis button ( ) .

5. Browse to or search for the relevant product on theSelect Product dialog, then clickSelect. Only one
product can be selected; an option tomulti-select products is not available.

6. After selecting the product, clickNext on theAdd Product to Terms list dialog.
7. In theAdd Product to Terms List dialog, clickAdd Term to add a new blank row to the dialog.
8. Enter the relevant terms, then clickAdd Term again to addmore terms.
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Note: No option is available in this dialog to add a Unit. It must be added after the product is added to the
list.

9. ClickFinish. The product is now available in the list.

Remove Products from a Price List

1. Follow the same initial steps as above for adding a product, but clickRemove Product instead of Add
Product.

2. TheRemove Terms for dialog displays, showing all the terms that will be affected.
3. ClickDelete to remove the product from the list.

4. Click the ellipsis button ( ), then either browse or search for a Product, and then clickNext.

5. ClickAdd Term and fill in the relevant fields.
6. ClickFinish.

Edit Price List Terms from a Product
Price lists can also be edited from product objects that appear in at least one price list. When viewing terms lists
for a product on theCommercial tab, the Value and Unit can be edited directly. The Value, Min Quantity, Max
Quantity, Start Date, and End Date values can be edited by right-clicking on a terms list and accessing theEdit
Terms dialog.

Editing Price Commercial Data Directly

1. In the Tree, navigate to and select the relevant product.
2. On theCommercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Double-click in anyValue field to edit the value.
4. Click the ellipsis button ( ) in theUnit field to edit the unit.
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Editing Commercial Data from the Edit Terms Dialog

1. In the Tree, navigate to and select the relevant product.
2. On theCommercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Right-click the right arrow next to the relevant term, then chooseEdit Term.

4. In theEdit Terms dialog, double-click inside the field for the term that you want to edit, then clickOK when
complete.

Add Terms to a Product

Terms can be added to a product from theEdit Terms dialog, or from theAdd Term to Product dialog. Follow
these steps to add a term from the 'Add Term to Product' dialog.

1. In the Tree, navigate to and select the relevant product.
2. On theCommercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Click theAdd Term link at the bottom of the list. Or, right-click on the right arrow next to any term and select

Add Term.
4. In theAdd Term to Product dialog, click the ellipsis button ( ).
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5. In theSelect Terms List dialog, browse to or search for the relevant commercial list, then clickSelect to
close the dialog.

6. ClickNext to go to theEnter Terms screen, then clickAdd Term to add a new row under Enter Terms.
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7. Enter the relevant terms, then clickFinish.

Remove a Single Term from a Product

1. Follow the steps outlined above to access theEdit Terms dialog.
2. Right-click the right arrow next to the preferred term, then chooseRemove Term.

Remove All Terms from a Product

Removing all terms from a product will remove the product itself from the terms list.

1. In the Tree, navigate to and select the relevant product.
2. On theCommercial tab, expand the Terms area. The content of the lists related to the product is displayed.

3. Right-click the right arrow next to the relevant term, then clickRemove Term.
4. TheRemove terms for product dialog displays.
5. Verify that you want to remove the listed terms, then clickDelete. All the product terms are removed, and the

product itself is also removed from the list.
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Copying Price Lists
You canmake a copy of a price list and use it as a price list in a different publication. You can also copy price lists
to Publisher publications to use as commercial data lists. For more information on Commercial Data, refer to the
Commercial Data section of thePublisher (Adobe InDesign Integration) documentation.

1. Navigate to the price list that you want to copy, then right-click and chooseCopy.

2. Navigate to and select the eCatalog that you want to copy the list to, then right-click and choosePaste.
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3. If the eCatalog already has a list, a warning dialog will display to let you know that the existing price list will be
deleted when you paste the new one. ClickOK to continue and overwrite the price list, or clickCancel to exit.

4. If the eCatalog does not already have a list, theDuplicate dialog displays.
5. Enter an ID andName for the new list, then check theDuplicate terms box if you want to copy the actual

contents of the list.

6. ClickOK. The copied terms list is now present in the eCatalog.
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Selecting Products for eCatalogs
There are twomethods of selecting the products that should be part of an eCatalog. One way is to use the
contents of the price list itself, which is achieved by selecting theAct as selection list on the price list. Refer to
theCreating a Price List topic for more information.

The secondmethod is to link a collection to your eCatalog. In the workbench, collections can be created in two
ways:

1. Using theSearch tab, perform a search, and create a collection of the results. This creates a dynamic
product selection for the catalog that can later be refreshed.

2. Using an import file, create a collection of the contents. This creates a static product selection for the
catalog. If you later want to alter the product selection, you will have to delete this file-created collection and
create a new one.

For information on how to create a collection using either method, refer to theCreating Collections topic in the
Getting Started documentation.

Note: It is strongly recommended to use a collection created from a search, since this collection can be
refreshed every time the eCatalog is exported. For more information, refer to theSelecting Products for
eCatalogs topic.

This topic explains how to add collections to eCatalogs.

Add a Dynamic Collection to an eCatalog Through Search
To add a dynamic collection to an eCatalog created from a search:

1. On theSearch tab, search to locate the products that you want to be part of the eCatalog.

2. When the search is complete, click the 'Save asCollection' button .
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3. In theSave as Collection in Background Process dialog, browse or search for the eCatalog that you
want to add the collection to.
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4. For theCollection Name parameter, add a Name for the new collection (IDs are autogenerated).
5. A background process launches.When complete, the collection is added to the eCatalog.

Add a Static Collection to an eCatalog Through a File
To add a static collection to an eCatalog created from a file:

1. Right-click on your eCatalog and selectCreate Collection from File.

2. In theCreate Collection From File dialog, locate the file to be imported.
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3. For the Collection Name parameter, add a Name for the new collection (IDs are autogenerated).
4. For the File Contains parameter, select if the import file contains IDs of products, classifications, or assets.
5. ClickOK to start a background processwhich will create the new collection.
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Creating an eCatalog Configuration
Another required step in creating an eCatalog is to add an eCatalog Configuration. This is an export
configuration that specifies the data to be included in the eCatalog, as well as the data format of the eCatalog.

To create and configure an eCatalog Configuration:

1. Navigate to the relevant eCatalog, then right-click and selectNew eCatalog Configuration.

2. TheConfigure eCatalogwizard displays on theSelect Format screen. The Configure eCatalog wizard is
based on theExport Manager with added functionality, allowing you tomap the prices from the price list
information of the current eCatalog into the selected output format. You can choose among the following
eCatalog formats, which are supported via export options:

l Excel: Refer to theExcel Format section of theData Exchange documentation for more information.

l BMEcat 1.2: An XML-based standard for electronic data transfer by electronic catalogs. Refer to the
BMEcat Format section of theData Exchange documentation for more information.

l Ariba CIF 3.0: A simple comma-delimited list of catalog items and their attributes. Refer to theAriba CIF
3.0 Format section of theData Exchange documentation for more information.

l cXML: Exports data using Ariba cXML 1.2 and is an XML-based language designed specifically for
communication of e-commerce business documents. Refer to the cXML Format section of theData
Exchange documentation for more information.

l xCBL: exports data using the CommerceOne XML-based language. Refer to the xCBL Format section of
theData Exchange documentation for more information.
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Configure an eCatalog Configuration for Excel
1. SelectExcel from the dropdown list on theSelect Format screen of the Configure eCatalog wizard, then

clickNext.

2. On theMap Data screen, click on the relevant information that you want included in the export (for instance,
<ID>), then click the arrow button in the right part of the window to add it to the list of data to be exported. At a
minimum, youmust map ID and a price column.Name is also recommended.

3. Tomap the price data, expandCommercial (eCatalog). Select the relevant price list (in this example,
'Price'), then click the arrow icon to add it as a column in the Excel sheet.

4. In theEnter Quantity Break dialog that displays, enter the quantity break value (e.g., 1), then clickSave.
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5. The price value ismapped, followed by the break number in brackets, e.g., [1].

6. If you would like to apply transformations to the values that display in the export, click the 'flipper' icon next
to Price to view the fields that have the transformation icon ( ) available. Whenmapping a commercial

value, you have the same transformations available as you would have for a product attribute, but the
available aspects differ.

For more information on applying aspect transformations to outbound data, refer to theAspect - Transform
Outbound topic in theData Exchange documentation. For a broader overview on applying transformations
to outbound data, refer to theOutbound Map Data - Transform topic in theData Exchange
documentation.

7. Click the transformation icon ( ) next to the Header field to change the header that will display in the Excel
export spreadsheet for the price value. In the Transformations dialog, enter the desired header in the
Source field, then clickSave.
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Note: If the header is not changed, then the header in the Excel sheet will be the same for all price
breaks, e.g., 'Price in SpringPrices.' As such, it is recommended to customize the header for each break,
for example, 'Price in SpringPrices - Break 1.'

8. Click the transformation icon ( ) next to theValue field if you want to apply a transformation to the values
that display in the price columns. If changing the aspect, the following selections are available:

l Price - default; the value field from the commercial list
l Currency - the unit from the commercial list
l Price and currency - both the value and the unit from the commercial list
l Currency ID - the ID of the unit from the commercial list
l Min Quantity - theMin. Quantity value from the commercial list
l Max Quantity - theMax. Quantity value from the commercial list
l Start Date - the Start Date value from the commercial list
l End Date - the End Date value from the commercial list

9. Repeat the process tomap values from additional price breaks. The following screenshot shows a sample
mapping with ID, Name, and three price breakswith transformations applied:
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10. ClickNext on theMap Data screen when finished.

11. On theAdvanced screen, additional options specific to eCatalog exports are included in addition to the
options available in the standard Export Manager. For information on the standard options available on this
screen, refer to theExport Manager - Advanced section of theData Exchange documentation. The
additional options for eCatalogs are highlighted in the below screenshot.
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l Use effective date: Select this option if you want the system to take the 'start date' and 'end date'
specified on the price list into consideration when exporting prices. 'Use effective date' ensures that prices
will only be included in the export if the effective date lies within the specified period. Leave this box
unselected to have the system disregard the 'start date' and 'end date' applied to products on the price list.

If selected, then specify one of the following options:

l SelectCurrent date of when export is initiated to ensure that the prices included in the export
have a start date that occurs on or before the date that the export is initiated. If the start date of a price
on the price occurs after the current date, then that price will not be included, since it is not yet valid.

l SelectEffective to ensure that the prices included in the export have a start date that occurs on or
before the date specified. Aswith the 'current date' option, if the start date of a price on the price list
occurs after the effective date, it will not be included in the export.

If no date span has been specified for the prices, the effective date will have no effect.

l Selfcontained references: Select this option if there is a need for the export to be self-contained. This
ensures that no referenceswill be allowed to point to anything outside of the export.

12. Click Next to advance to theSelect Delivery Method screen.
13. Select File, then clickFinish.
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Configure an eCatalog Configuration for BMEcat
This section describes how to configure information specific to eCatalogswhen using the BMEcat format for your
eCatalog Configuration. For full details on how to configure the rest of the information required for a BMEcat
export, refer to theBMEcat Format section of theData Exchange documentation.

1. SelectBMEcat from the dropdown list on theSelect Format screen of the Configure eCatalog wizard.
2. Fill out any relevant fields on the screen, then clickNext.
3. On theMap Data screen, the followingmandatory fields aremarked in red text with an asterisk: Supplier

Article ID, Short Description, Order Unit, and Price. Since this guide concerns eCatalogs, thePrice field will
bemapped.

4. Tomap the price data, expandCommercial (eCatalog). Select the relevant price list (in this example,
'Price'), then click the arrow icon next toPrice to add it as a column in the Excel sheet.
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5. In theEnter Quantity Break dialog that displays, enter the quantity break value (e.g., 1), then clickSave.

6. The price value ismapped, followed by the break number in brackets, e.g., [1].

7. If you would like to apply transformations to the values that display in the export, click the 'flipper' icon next
to Price to view the fields that have the transformation icon ( ) available. Whenmapping a commercial

value, you have the same transformations available as you would have for a product attribute, but the
available aspects differ. The available aspects in the price transformations for the BMEcat format are the
same as those available for Excel exports. Refer to the above subsection, 'Configure an eCatalog
Configuration for Excel,' for more information.

For more information on applying aspect transformations to outbound data, refer to theAspect - Transform
Outbound topic in theData Exchange documentation. For a broader overview on applying transformations
to outbound data, refer to theOutbound Map Data - Transform topic in theData Exchange
documentation.
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Note: Commercial (eCatalog) > Price values can bemapped to other fields other than 'Price.' For
example, You couldmap to the 'MinimumQuantity' field, then apply an Aspect transformation to pull the
'Min Value' value from the price list.

8. ClickNext on theMap Data screen when finished.

9. On theAdvanced screen, additional options specific to eCatalog exports are included in addition to the
options available in the standard Export Manager. For information on the standard options available on this
screen, refer to theExport Manager - Advanced section of theData Exchange documentation. The
additional options for eCatalogs are the same as those available for Excel exports (User effective date, etc.).
Refer to the above subsection, 'Configure an eCatalog Configuration for Excel,' for more information.

10. Click Next to advance to theSelect Delivery Method screen.
11. Select File, then clickFinish.

Configuring eCatalog Configurations for Other Formats
The process for creating an eCatalog Configuration for other available formats (Ariba CIF 3.0, cXML, and
xCBL) is very similar to that for creating configurations for Excel and BMEcat exports. Though the available data
fields differ on theMap Data screen of theConfigure eCatalogwizard for each format, the process for
mapping Commercial (eCatalog) > Price is the same, and the available aspects for transformations are the
same. Additionally, the same options ('Use effective date,' etc.) are available on theAdvanced screen.

Editing an Existing eCatalog Configuration
1. To edit an existing eCatalog Configuration, right-click the configuration and selectEdit.

2. TheConfigure eCatalogwizard displays. Follow the same steps as you would when creating a new
configuration.
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Exporting an eCatalog
1. In the Tree, right-click the relevant eCatalog, then selectExport eCatalog. TheExport eCatalogwizard

displays on theRefresh Collection screen.
2. SelectRefresh before each run if you want the collection to be refreshed before each export. This option is

only relevant for collections created from a search. It does not apply if your collection was created from a list
or if you are using the price list as the product selection.

3. On theSchedule Process screen, specify whether you want to export the eCatalog immediately or at a
specified time in the future, then clickNext. You have the following options:

l Now: Starts the eCatalog Export process and delivers the eCatalog as specified in the eCatalog
Configuration.

l Later: Schedules a single delivery in the future at the specified time and date.
l Weekly: Schedules a recurring eCatalog export for one or more of the days of the week. This option
requires a time, a start date, and optionally an end date. If no end date is specified, the eCatalog scheduling
process runs until it is endedmanually.

l Monthly: Schedules a recurring export of the eCatalog for a specific day of everymonth.
l Later and repeat: Schedules delivery in the future at the specified time and date and at an interval given in
minutes.

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed.When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause confusion
about when the job will run since the scheduled time is not automatically converted to accommodate
potential differences in time zones.
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4. On theName Process, provide a name for the process. An auto-generated name is provided, but you can
change it to make it easier to identify the process.

5. ClickFinish to either start the export process or a scheduling process, depending on the specified settings.

© Stibo Systems - Internal - Release 2023.3 (11.3) - September 2023 48


	Table of Contents
	eCatalogs
	eCatalog Elements
	eCatalog Price Lists and Commercial Data Lists

	Creating an eCatalog
	Creating a Price List
	Defining Import Settings for Price Lists
	Sample Excel Price List Load File
	Price Example
	Prices with Units and Dates

	Creating an Import Configuration for a Price List
	Mapping Commercial Data in the 'Map Data' Step
	Completing the Import Configuration

	Editing a Saved eCatalog Import Configuration

	Importing Prices
	Viewing and Searching Price Lists
	View Terms from a Price List
	Search Terms from a Price list

	View Terms from a Product

	Editing Price Lists
	Edit Price List Terms from a Price List
	Editing Terms Directly
	Editing Terms from the Edit Terms Dialog
	Add Terms to a Price List
	Remove Terms from a Price List
	Add Products to a Price List
	Remove Products from a Price List

	Edit Price List Terms from a Product
	Editing Price Commercial Data Directly
	Editing Commercial Data from the Edit Terms Dialog
	Add Terms to a Product
	Remove a Single Term from a Product
	Remove All Terms from a Product


	Copying Price Lists
	Selecting Products for eCatalogs
	Add a Dynamic Collection to an eCatalog Through Search
	Add a Static Collection to an eCatalog Through a File

	Creating an eCatalog Configuration
	Configure an eCatalog Configuration for Excel
	Configure an eCatalog Configuration for BMEcat
	Configuring eCatalog Configurations for Other Formats
	Editing an Existing eCatalog Configuration

	Exporting an eCatalog

